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ОБОЗНАЧЕНИЯ  И СОКРАЩЕНИЯ

802.11 - стандарт IEEE, в котором определяется порядок доступа к передающей среде и приводятся спецификации физического уровня для беспроводных локальных сетей со скоростью до 2 Мбит/с. Стандарт 802.11 распространяется на высокочастотные радиоканалы DSSS и FHSS, а также на инфракрасные каналы.

802.11а - редакция стандарта 802.11 IEEE, в которой рассматриваются сети, работающие со скоростями до 54 Мбит/с по технологии DSSS.

802.11b - редакция стандарта 802.11 IEEE, в которой рассматриваются сети, работающие со скоростями до 11 Мбит/с по технологии DSSS.

802.1lg - редакция стандарта 802.11 IEEE, в которой рассматриваются сети, работающие со скоростями до 54 Мбит/с по технологии DSSS, обратно совместимые со стандартом 802.11b.

802.1х - стандарт IEEE аутентификации и контроля доступа на канальном уровне.

AAA (authentication, authorization, accounting) — это набор сервисов сетевой безопасности, которые определяют подход для организации контроля доступа к сети. 

Authentication (аутентификация) — процес подтверждения пользователем своей подлиности, подтверждения того, что пользователь запрашивающий сервис легитимный пользователь системы (в системе существует учетная запись для этого пользователя). Аутентификация может осуществляться по паролю, смарт-карте, сертификату и др. 

Authorization (авторизация) — определяет какие сервисы будут доступны или какие сервисы будут запрещены пользователю прошедшему аутентификацию. 

Accounting (учёт) — слежение за потреблением сетевых ресурсов пользователем. 

Access point (точка доступа) - тип базовой станции, которую беспроводная локальная сеть использует для обеспечения взаимодействия беспроводных пользователей с проводной сетью и осуществления роуминга в пределах здания.

Autentificator (Аутентификатор) - в протоколе 802.1х посредник между сервером аутентификации, например RADIUS, и претендентом. В беспроводных сетях обычно размещается на точке доступа; в проводных сетях эту функцию могут выполнять высококлассные коммутаторы.

DNS (Domain Name System) - Cистема доменных имён
DSSS (Direct Sequence Spread Spectrum) - один из двух подходов к передаче радиосигналов с изменяемым спектром. При использовании технологии DSSS поток передаваемых данных разбивается на небольшие кусочки, каждому из которых выделяется широкополосный канал. На передающем конце информационный сигнал комбинируется с последовательностью битов, передаваемых с более высокой скоростью, которая разделяет данные в соответствии с коэффициентом изменения.

ЕАР (Extensible Authentication Protocol) - гибкий протокол аутентификации, первоначально спроектированный для аутентификации в протоколе РРР, а позже включенный в стандарт 802.1х.

Eduroam  (Education Roaming) - Европейская система роуминговой аутентификации мобильных пользователей. 

FLRS (Federation level RADIUS server) - RADIUS сервер уровня федерации Eduroam.

PEAP (Protected Extensible Authentication Protocol) - Протокол, инкапсулирующий EAP внутри TLS туннеля.
QoS (Quality of Service — качество обслуживания) - качество и класс предоставляемых услуг передачи данных.

RADIUS (Remote Authentication Dial-In User Service) - Протокол для реализации аутентификации, авторизации и сбора сведений об использованных ресурсах, разработанный для передачи сведений между сервером и оборудованием (клиентом).

Supplicant (Претендент) - в протоколе 802.1х клиентское устройство, нуждающееся в аутентификации.

TKIP (Temporal Key Integrity Protocol) (Протокол целостности временных ключей) - основанный на алгоритме RC4 протокол шифрования, который избавлен от многих слабостей оригинального статического протокола WEP. Протокол TKIP это необязательная часть стандарта 802.11i. Он обратно совместим с WEP и не требует замены оборудования.

TLRS (Top-level RADIUS server) - RADIUS сервер уровня конфедерации Eduroam.

TLS (Transport Layer Security) - Защищенный протокол транспортного уровня.

VLAN (Virtual Local Area Network) - Виртуальная локальная сеть.
WEP (Wired Equivalent Privacy) - в стандарте 802.11 необязательный механизм обеспечения безопасности, в котором для шифрования трафика в беспроводной сети применяется алгоритм RC4.
Wi-Fi (Wireless Fidelity) - процедура сертификации, разработанная организацией Wi-Fi Alliance, которая гарантирует возможность совместной работы различных продуктов, реализующих стандарт 802.11.

WPA (Wi-Fi Protected Access) - защищенный доступ к Wi-Fi. Протокол безопасности, определенный Альянсом Wi-Fi, позволяющий компьютерным устройствам периодически получать новые ключи шифрования. В WPA версии 1 применяются временный протокол целостности ключа TKIP и WEP; в WPA версии 2 используется весь стандарт 802.11i, включающий AES.

WLAN (Wireless Local Area Network) (Беспроводная локальная сеть) – локальные сети стандарта 802.11.

WiSM  (Cisco Wireless Services Module) - Plug-in плата для Cisco Catalyst 6500 состоящая из двух Cisco 4404 контроллеров беспроводной сети.  

ВВЕДЕНИЕ

В последние годы беспроводные сети передачи информации становятся одним из основных направлений развития телекоммуникационной индустрии. И если ранее проводные сети опережали беспроводные по ряду параметров, таких как простота развертывания, надежность и защищенность. То сейчас технические характеристики двух подходов к передаче информации примерно совпадают.

Основным достоинствами беспроводных сетей являются:
— гибкость архитектуры, т. е. возможности динамического изменения тополо​гии сети при подключении, передвижении и отключении мобильных пользовате​лей без значительных потерь времени;
— высокая скорость передачи информации (1-10 Мбит/с и выше);
— быстрота проектирования и развертывания;
— высокая степень защиты от несанкционированного доступа;
— отказ от дорогостоящей и не всегда возможной прокладки или аренды опто​волоконного или медного кабеля.

Целью данной работы является разработка архитектуры аутентификации мобильных пользователей, позволяющая включить корпоративный сегмент сети БГУ в национальный сегмент международной системы роуминговой аутентификации eduroam.

Задачи данной работы:

1. Выполнить анализ  структуры международной системы роуминговой аутентификации Eduroam
2. Создать кампусный беспроводной сегмент системы Eduroam в сети БГУ.

3. Разработать систему роуминговой аутентификаци на основе иерархии RADIUS серверов.

4. Реализовать тестовую модель кампусного сегмента БГУ и провести экспериментальные исследования по ее проверке.

Eduroam (англ. "Education Roaming" - рус. "Образовательный Роуминг") создан в 2003 году рабочей группой TERENA (TF-Mobility), собравшей сетевую инфраструктуру на основе протоколов RADIUS и IEEE 802.1X с целью обеспечения единой связи между всеми научными и образовательными сетями. Тестовый запуск сети проводилось между 5 организациями, находившимися в Нидерландах, Финляндии, Португалии, Хорватии и Великобритании. Позже другие национальные научные и образовательные сети по всей Европе присоединились к этой инфраструктуре, которую впоследствии назвали eduroam. Вскоре к сети начали присоединяться другие, неевропейские страны, первой из которых стала Австралия (декабрь 2004 года).

Сервис eduroam предоставляет возможность для академической мобильности  студентов, аспирантов, преподавателей, научных сотрудников путем обеспечения беспроводного широкополосного доступа при посещении национальных и зарубежных учебных заведений.

Любой из выше указанных пользователей - сможет использовать беспроводной широкополосный доступ в сеть этой организации, пройдя аутентификацию с использованием своих домашних реквизитов. После этого он будет авторизован для доступа к информационным ресурсам по правилам организации, где он в данный момент находится.

Развитие данного сервиса можно считать новым этапом распространения и внедрения в жизнь беспроводных технологий. Крупнейшие университеты мира входят в состав конфедерации  Eduroam, на очереди БГУ.

ГЛАВА 1

Краткий обзор литературы
В интернете можно найти множество ресурсов описывающих планирование и создание полноценного кампусного сегмента роуминговой федерации. Причем настройку кампусного сегмента можно разбить на группы. Первичной является настройка RADIUS сервера для этой цели используется Microsoft IAS (Internet Authentication Service службы проверки подлинности в интернете) под Windows 2003. Наиболее точную инструкцию можно найти на сайте [i3]. Далее следует настройка контроллеров беспроводного доступа Cisco WiSM, описание которой можно найти в статье [7]. Последний пункт, настройка компьютера пользователя, достаточно хорошо описана на многих сайтах конфедерации Eduroam, к примеру[i4].   
Общие вопросы, касающиеся структуры Eduroam и использующихся в ней протоколов можно найти в статьях [5][6], а также на официальном сайте [i2].
ГЛАВА 2
МЕТОДИКА ИССЛЕДОВАНИЯ
МОДЕЛЬ КАМПУСНОГО СЕГМЕНТА БЕСПРОВОДНОЙ СЕТИ БГУ И ЕЕ ИНТЕГРАЦИЯ В МЕЖДУНАРОДНУЮ ФЕДЕРАЦИЮ EDUROAM
2.1 Eduroam

Eduroam (educational roaming образовательный роуминг) - это общемировой безопасный сервис доступа к сети, разработанный для международного научного и образовательного сообщества. Благодаря eduroam ученые и студенты могут получить доступ к сети Интернет на территории любого института - участника проекта, просто открыв свой ноутбук.

Развитие данного сервиса началось в Европе в 2003.

В настоящий момент существует две региональных eduroam конфедерации в Европе и Азиатско-Тихоокеанском регионе.

Eduroam в Европе - конфедерация, представленная 36 федерациями национального уровня. Она включают в себя сотни учреждений, большинство из  которых являются владельцами  и управляют инфраструктурой данной службы. Национальная и международная координация этой инфраструктуры осуществляется национальными операторами роуминга и центральной, так называемой Operational Team (Операционной Командой) eduroam, которая финансируется проектом GÉANT (GN3). Повседневную эксплуатацию выполняет eduroam Operational Team (Операционная Команда) при участии  Srce, SURFnet, UNI-C и TERENA.

Инструменты для контроля службы и поддержки конечных пользователей обеспечивает eduroam Service Activity of the GÉANT (GN3).

Присоединение к конфедерации Eduroam позволит БГУ, да и всему университетскому сообществу нашей страны, будь то студенты либо преподавательский состав, более тесно сотрудничать и общаться с  европейскими коллегами.
2.2 Технологическая инфраструктура конфедерации Eduroam

Инфраструктура конфедерации опирается на распределенный комплекс серверов аутентификации, авторизации и учета (AAA). Текущая конфигурация использует RADIUS, как протокол AAA. То есть техническая инфраструктура  представляет собой иерархическую последовательность RADIUS серверов, расположенных в различных учреждениях, которые прямо или косвенно связаны с национальным RADIUS прокси-сервером, который, в свою очередь связан с серверами  более высокого уровня.

На рисунке 1.1 представлена схема подключения сервера eduroam национального уровня на базе академсети BASNET к RADIUS-серверу высшего наднационального уровня Европейской конфедерации сервиса eduroam.
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Рисунок 1.1 – Европейский сегмент международной системы роуминговой аутентификации в науке и образовании eduroam. 
Top-level RADIUS Server (TLRS) (RADIUS сервер уровня конфедерации) - В настоящее время TLRS RADIUS серверы для Европейской конфедерации расположены в Нидерландах и Дании. Каждый сервер имеет список присоединенных доменов страны (nl, .dk, .hr, .de). Они принимают запрос на аутентификацию от домена федерации, для которого являются авторитетными, обрабатывают их и посылают обратно. Что же касается запросов из других частей мира (.au, .jp, .cn) их также обрабатывают европейские TLRS сервера.
Federation level RADIUS Server (FLRS) (RADIUS сервер национального уровня/уровня федерации) – FLRS имеет список серверов подключенных учреждений.  Он принимает запросы от сервера конфедерации и учреждения связанного с ним, и занимается передачей запросов в надлежащие учреждения конфедерации. 
Home and Remote Institutional RADIUS Server - RADIUS-сервер учреждения, отвечающий за аутентификацию собственных пользователей (в университетском городке, либо удаленно, при посещение другого учреждения). Также стоит заметить, что настройка RADIUS-сервера учреждения является наиболее сложной,  потому как сервера более высокого уровня просто запрашивают proxy, в то время как, сервер учреждения должен обрабатывать поступающие запросы.

Network access elements - switch или беспроводная точка доступа, которая предоставляет клиентам доступ в локальную сеть. Международная система роуминговой аутентификации eduroam не зависит от технологии доступа к сети. Пользователи Eduroam могут получить доступ к службе по беспроводной или проводной сети.

Supplicants - устройство конечного пользователя, которое аутенцифицирует его в сети. Supplicant - программное обеспечение, разработанное для сетевого доступа, являющееся или не являющееся частью операционной системы.

Иерархическая система RADIUS серверов создается для того чтобы транспортировать запрос аутентификации пользователя из посещаемого учреждения в домашнее. Обычно в каждом корпоративном сегменте развертывается RADIUS-сервер, который подключается к локальной базе данных, хранящей информацию о легитимных пользователях. Этот RADIUS-сервер подключается к национальному RADIUS-серверу, который, в свою очередь, подключается к европейскому (или глобальному) RADIUS-серверу. Так как пользователи используют имена в формате “user@realm”(realm - доменное имя домашнего учреждения), то RADIUS-сервера могут использовать эту информация для маршрутизации на следующий в иерархии уровень, пока не будет достигнуто домашнее учреждение.

Для надежной передачи информации об аутентификации пользователя через RADIUS-инфраструктуру к домашнему учреждению, точки доступа или коммутаторы, развернутые в посещаемом учреждении, используют стандарт IEEE 802.1X, который включает в себя использование Extensible Authentication Protocol (EAP), Расширяемого Протокола Аутентификации. Стандарт 'IEEE 802.1X' определяет процесс инкапсуляции данных EAP, передаваемых между запрашивающими устройствами (клиентами), системами, проверяющими подлинность (точками беспроводного доступа), и серверами проверки подлинности (RADIUS). Использование соответствующего EAP метода создает тоннель безопасности, по которому передается актуальная информация аутентификации (имя пользователя / пароль и т.д.). RADIUS транспортирует имя пользователя в Атрибут User-Name, который остается “видимым”. Он также транспортирует полезную нагрузку EAP, которая находится в зашифрованном виде и не видна промежуточным серверам, только серверу корпоративного сегмента. После успешной аутентификации в домашнем учреждении и авторизации в посещаемом, пользователю предоставляется доступ к сети путем размещения в конкретной VLAN.
2.3 Создание кампусного сегмент международной системы роуминговой аутентификации Eduroam

Рассмотрим основные действия необходимые для настройки кампусного сегмента Eduroam.

1. Планирование сетей. На этой стадии осуществляется создание либо интеграция  в уже существующую сеть беспроводного сегмента Eduroam . Определяются устройства, обеспечивающие его работу. Планируются WLAN (SSID) и VLAN, выделяются  диапазоны IP адресов для виртуальных сетей и IP адреса устройств. Оговариваются вопросы способов раздачи IP адресов (динамические или  статические).  Название беспроводного сегмента в сервисе DNS. 

2. Конфигурирование RADIUS сервера. Отметим, что использование  RADIUS сервера других целей (например, VPN), может повлечь за собой возникновение непредвиденных ошибок. Поэтому для создания кампусного сегмента необходимо сконфигурировать отдельный RADIUS сервер. В тоже время RADIUS сервер может выполнять и другие функции помимо аутентификации (например, прокси-сервер).

Первоначально определяется база данных, в которой хранятся учетные данные пользователей. Такими базами могут быть собственная база данных сервера RADIUS (Native) или внешние типа Microsoft Active Directory (AD), OpenLDAP, Novell eDirectory, Cerebrum.   

В качестве RADIUS серверов часто используются:

· FreeRADIUS 1.x

· FreeRADIUS 2.x

· Microsoft IAS (Windows 2003 server)

· Microsoft NPS (Windows 2008 server)
А в качестве баз данных:

· Microsoft Active Directory (AD)

· OpenLDAP

· Novell eDirectory

· Cerebrum

3. Конфигурирование беспроводного контроллера. Осуществляется в несколько этапов:

· Создание виртуального интерфейса. Виртуальный интерфейс создается для каждого VLAN, который, в свою очередь, привязывается к определенной группе пользователей (к примеру, гости, студенты, сотрудники). 

· Определение RADIUS сервера. Для корректной совместной работы беспроводного контроллера и RADIUS сервера необходимо для данных устройств установить общий секрет.  Также следует помнить, что RADIUS сервер использует для аутентификации порт UDP 1812

· Создание WLAN(SSID). На этом этапе создается беспроводная сеть Eduroam и для нее настраиваются параметры безопасности и QoS.

4. Размещение точек доступа. Здесь стоит отметить, что данный процесс может осуществляться исходя из двух критериев: 

· Достижение оптимальной мощности сигнала на всей территории, охватываемой беспроводной сетью.

· Покрытие необходимой области, используя наименьшее количество точек.

Последний четвертый этап не осуществлялся при создании кампусного сегмента, а не интеграции его в уже существующую беспроводную сеть.
2.4 Главные функциональные компоненты сетевой инфраструктуры сервиса eduroam в корпоративной сети БГУ
· Сервер удаленного доступа (Network Access Server, NAS) –  контроллер удаленного беспроводного доступа WiSM (Series Wireless Services Module) Cisco Catalyst 6500, обеспечивающий взаимодействие облегченных точек беспроводного доступа.  

· Точки удаленного доступа, позволяющие обеспечить доступ клиентов к сервисам локальной сети

· Клиент (Client/Supplicant) – оконечное оборудование пользователя  (netbook, notebook, мобильное устройство доступа) которое регулирует пользовательскую аутентификацию в сети.  Supplicant - программное обеспечение, входящее в саму операционную систему или устанавливаемое отдельно на устройство, разработанное для обеспечения доступа в сеть.

· Сервер аутентификации (Authentication Server, AS) – сервис, обеспечивающий аутентификацию и авторизацию клиентов. Сервер аутентификации имеет базу данных пользовательских учетных записей (например, именя входа и пароль, сертификат), которые используются  для аутентификации клиентов. Eduroam основан на сервере аутентификации RADIUS.

Взаимодействие основных компонентов сетевой инфраструктуры  eduroam показано на рисунке 1.2.
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Рисунок 1.2 – Сетевая инфраструктура сервиса eduroam в БГУ.
2.5 Реализация тестовой модели кампусного сегмента БГУ

Исходя из выше описанного, для реализации тестовой модели кампусного сегмента БГУ, фактически требуется развернуть корпоративный сегмент, после чего необходимо “подсоединить” его к сегменту национальному.

 Первый шаг, который был предпринят - в создаваемую модель был добавлен сервер аутентификации RADIUS. Данный сервер создается на базе службы проверки подлинности в интернете Microsoft IAS (Internet Authentication Service службы проверки подлинности в интернете) под Windows 2003 Enterprise edition (используется именно данная версия во избежание проблем совместимость с корневым сервером сертификатов). Далее была произведена настройка беспроводного контроллера Cisco WiSM, который устанавливается в коммутатор Cisco Catalyst, как плата расширения. Плата Cisco WiSM состоит из двух контроллеров Cisco 4404, WiSM-A и WiSM-B, каждый из которых управляет 150 точками доступа Cisco Aironet 1131. 

Для настройки контроллеров беспроводного доступа были выполнены следующие действия:

На коммутаторе Catalyst 6505 сконфигурированы:

· VLAN для беспроводной подсети WLAN eduroam
· DHCP pool для раздачи пользователям WLAN  eduroam IP адресов
На контроллере беспроводного доступа WiSM: 
· Определен SSID  для  WLAN eduroam 

· Определен RADIUS сервер для данного клиента

· Сконфигурированы параметры безопасности

В итоге была реализована следующая схема кампусного сегмента (рисунок 1.3).
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Рисунок 1.3 – Кампусный беспроводной сегмент системы Eduroam в сети БГУ.
Для настройки сервера аутентификации  RADIUS были выполнены следующие действия:
1. Установлена операционная система Windows 2003, версия Enterprise edition. 

2. Данный сервер был введен в домен CIT, после чего он настраивался как дополнительный контроллер домена (на компьютер реплицировалась база AD), это было сделано для того чтобы дальнейшая аутентификации и авторизации пользователей, проводилась для групп пользователей действительно принадлежащих к домену CIT.

3. Затем на компьютере был установлен DNS сервер. Поскольку bsu – однокомпонентное доменное имя неподдерживаемое Microsoft и нерегистрируемое в интернете, то на DNS сервере были выполнены две дополнительные настройки (для видимости других DNS с однокомпонентным именем, для динамического обновления корневой зоны).

4. Далее на компьютере был установлен центр сертификации Enterprise Subordinate CA(подчиненный ЦС предприятия). Перед установкой ЦС был установлен IIS (Internet information services), данный сервис необходим для правильной работы центра сертификации.

5. Затем, при помощи центра сертификации, был выписан сертификат необходимый для работы с протоколом EAP-PEAP.

6. Следующим шагом была установка IAS (Internet Authentication Service, служба проверки подлинности в интернете).

7. При помощи этой службы были выполнены следующие действия:

1) Подключение службы проверки подлинности к домену и серверу сертификатов.

2) Добавление клиентов в IAS, отправляющих запросы на аутентификацию RADIUS серверу, который, в свою очередь, либо обрабатывает их на месте (если пользователь принадлежит организации, в которой установлен данный сервер),  либо отправляет дальше по цепочке RADIUS серверов подключенных к Eduroam. Было создано три клиента: два беспроводных контроллера Cisco WiSMA, Cisco WiSMB, а также сервер аутентификации RADIUS национального уровня принадлежащий академии наук (basnet).   

3) Добавление группы серверов в IAS, необходимых для перенаправления запросов аутентификации на удаленные группы серверов. Была создана одна группа: Eduroam (сервера корпоративного, национального и наднационального уровней, относящиеся к данной конфедерации).

4) Добавлены политики запросов на подключение. Политики запросов на подключение представляют собой наборы условий и параметров профиля, предоставляющие администратору сети гибкие средства задания правил проверки подлинности и учета входящих запросов.

Были созданы три политики запросов на подключение:

· Для пользователей БГУ, пытающихся получить доступ из внешней сети; 

· Для пользователей БГУ, пытающихся получить доступ из внутренней сети; 

· Для eduroam гостей внутренней сети со своими логином и паролем, пытающихся получить доступ из внутренней сети;

5)  Добавлены политики удаленного доступа. Политики удаленного доступа — это упорядоченный набор правил, определяющих порядок авторизации подключения или отказа в подключении. Для каждого правила имеется одно или несколько условий, набор параметров профиля и настройка разрешений удаленного доступа.

Были созданы две политики удаленного доступа: для доступа из внешней и из внутренней сети.

Подробная настройка сервера аутентификации  RADIUS описана в следующей главе.

Для настройки клиента (supplicant) на компьютере пользователя под операционной системой Windows 2007 было сделано следующее:

· Настроено имя сети – SSID сети, к которой вы хотите подключиться

· Настроен тип безопасности –WPA
· Настроен тип шифрования –TKIP
· Настроен метод проверки подлинности - EAP MSCHAPv2 

В результате проделанной работы был реализован корпоративный сегмент БГУ, который затем был успешно встроен в национальный сегмент Eduroam (рисунок 1.4).
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Рисунок 1.4 – Национальный сегмент международной системы роуминговой аутентификации eduroam.
Также были успешно проведены три эксперимента тестирующие его работу:

· Пользователь БГУ из домашней сети аутентифицируется через прокси RADIUS серверов в домене BSU и получает доступ к услугам в домашней сети.

· Гость подключается к беспроводному сегменту eduroam, его учетные данные через цепочку прокси RADIUS серверов передаются в его домашнюю сеть, где происходит аутентификация. Ответ передается в кампусный сегмент eduroam  БГУ и гость получает доступ к услуге Интернет. 

· Пользователь БГУ из гостевой сети аутентифицируется через цепочку прокси RADIUS серверов в домене BSU и получает доступ к услугам в гостевой сети.
ГЛАВА 3

ОСНОВНЫЕ РЕЗУЛЬТАТЫ
Настройка Internet Authentication Service (IAS)
Шаг 1.Установка IAS (Windows 2003).
Откройте Control Panel → Add or Remove Programs → Add/Remove Windows Components.

Выберите Networking Services и кликните на Details.
Поставьте отметку напротив Internet Authentication Service. Теперь, для установки IAS, кликните ОК, Next и Apply.
Шаг 2. Подключение к домену и серверу сертификатов.

В меню start выберите Control Panel → Administrative Tools → Internet Authentication Service. Затем в контекстном меню выберите Action и кликните Register Server in Active Directory для регистрации сервера в Active Directory.
Теперь выполните запрос сертификата необходимого для активации протокола PEAP .  Для  этого установите две службы Windows: CA (Certificate Services) и IIS (Internet information services). 

Для установки CA откройте Control Panel → Add or Remove Programs → Add/Remove Windows Components. Выберите Certificate Services и кликните на Details. Поставьте отметку напротив Certificate Services и кликните ОК.
Для установки IIS откройте Control Panel → Add or Remove Programs → Add/Remove Windows Components. Выберите Application Server и кликните на Details. Поставьте отметку напротив Internet information services, а также обязательно установите галку напротив ASP.NET и кликните ОК.
Чтобы установить новые компоненты нажмите Next и Apply.

Во время установки CA выберите Enterprise Subordinate CA(подчиненный ЦС предприятия).
Затем задайте имя новому ЦС и выберите корневой центр сертификации (в нашем случае ns на bsuad).
Для добавления сертификата выполните следующие действия:

· В меню start выберите Run
· Пропишите команду mmc и нажимите OK.

· В открывшемся окне  выберите File→Add/Remove Snap-in.

· Нажмите на Add… во вкладке Standalone.

· Выберите Certificates и кликните на Add.

· Выберите Computer account и нажимите на Next.

· Выберите Local computer и кликните на OK.

· В открытых окнах кликните на Close, затем на OK.
Нажмите на знак плюс перед Certificates. Щелкните правой кнопкой мыши на Personal, выберите All tasks, а затем запросите новый сертификат Request New Certificate. 
Следуйте инструкциям на экране, пока новый сертификат не будет создан (сертификат выписывается для контроллера домена (Domain controller)). Закройте окно консоли.
Если все верно, то на сервере сертификатов (Administrative Tools → Certification Authority) появится запрошенный сертификат.
Шаг 3. Добавление клиентов в IAS.

Клиенты отправляют запросы на аутентификацию RADIUS серверу, который либо обрабатывает их на месте (если пользователь принадлежит организации, в которой установлен данный сервер),  либо отправляет дальше по цепочке RADIUS серверов подключенных к Eduroam.

В нашем случае создается три клиента:

· Два контроллера беспроводного доступа Cisco WiSM-A и Cisco WiSM-B
· Прокси RADIUS сервер национального уровня (в нашем случае академия наук).

Для создания клиентов откройте Start → Control Panel → Administrative Tools → Internet Authentication Service.

Убедитесь в том, что IAS работает, в противном случае нажмите на кнопку Action и на кнопку Start Service.

· Щелкните правой кнопкой мыши на RADIUS Clients , выберите New RADIUS Client , введите Friendly Name и IP адрес, затем нажмите ОК.

· В качестве Client-Vendor выбирите RADIUS Standard.

· Shared Secret на клиенте и на IAS должны совподать. 
Шаг 4. Добавление группы серверов в IAS.

Для перенаправления запросов аутентификации на IAS должны быть настроены группы серверов.

Щелкните правой кнопкой мыши на Remote RADIUS Server Groups и выберите New Remote RADIUS Server Group.
· Нажмите на кнопку Next

· Выберите "Custom" и введите имя для группы серверов

· Если это группа серверов для подключения к Eduroam, группа должны  иметь имя Eduroam.

· Нажмите на кнопку Add, чтобы добавить RADIUS сервер в группу серверов.

· На вкладке Address, введите IP-адрес или DNS-имя сервера.

· На вкладке Authentication/Accounting заполните Authentication port и shared secret.

· Нажмите на кнопку "OK", затем  Next.

· Снимите галочку со Start the New Connection Request Policy Wizard when this Wizard closes.

· Нажмите на кнопку Apply.
В нашем случае создается одна группа серверов Eduroam.
Шаг 5. Политики запросов на подключение.

Политики запросов на подключение представляют собой наборы условий и параметров профиля, предоставляющие администратору сети гибкие средства задания правил проверки подлинности и учета входящих запросов. Поскольку данная инструкция описывает эксперимент по настройке ISA на обработку запросов 

· пользователей БГУ, пытающихся получить доступ из внешней сети(we_eduroam); 

· пользователей БГУ, пытающихся получить доступ из внутренней сети(Local); 

· eduroam гостей внутренней сети со своими логином и паролем, пытающихся получить доступ из внутренней сети(eduroam); (именно в таком порядке).
Создадим три Connection Request Policy, настроив дополнительные RADIUS атрибуты. Атрибуты RADIUS служат для передачи сведений, используемых для идентификации, проверки полномочий, конфигурации, а также для передачи пользователю той или иной информации.
a. We_eduroam
Для создания новой политики выполните следующие действия:

1. Щелкните правой кнопкой мыши на Connection Request Policy и выберите New Connection Request Policy.

2. Нажмите на кнопку Next.
3. Выберите A custom policy, заполните  Policy name (we_eduroam) и нажмите Next. 

4. Нажмите на кнопку Add , чтобы добавить критерии для подключения.

· Логин пользователя в Eduroam записывается следующим образом username@realm, где realm - доменное имя домашнего учреждения (для БГУ bsu.by).

5. Выберите User-Name и нажмите кнопку Add. Заполните критерий:     .*@ bsu.by
6. Выберите Client-IP-Address и нажмите кнопку Add. Заполните критерий: 80.94.174.231
7. Нажмите на кнопку Next, а затем Edit Profile.

8. На вкладке Authentication укажите, куда запрос на проверку подлинности должно быть направлен: Authenticate request on this server.

9. На вкладке Attributes выберите Attribute: User-Name и нажмите кнопку Add. Под Find: (.*)@(.*), а под Replace with: CIT\$1
10. Нажмите на кнопку OK, затем Next и Apply.
b. Local
Для создания новой политики выполните следующие действия:

1. Щелкните правой кнопкой мыши на Connection Request Policy и выберите New Connection Request Policy.

2. Нажмите на кнопку Next.
3. Выберите A custom policy, заполните  Policy name (Local) и нажмите Next. 

4. Нажмите на кнопку Add , чтобы добавить критерии для подключения.

· Логин пользователя в Eduroam записывается следующим образом username@realm, где realm - доменное имя домашнего. учреждения (для БГУ bsu.by).

5. Выберите User-Name и нажмите кнопку Add. Заполните критерий:     .*@ bsu.by.
6. Выберите Client-IP-Address и нажмите кнопку Add. Заполните критерий: 10.127.255.9.
7. Нажмите на кнопку Next, а затем Edit Profile.

8. На вкладке Authentication укажите, куда запрос на проверку подлинности должно быть направлен: Authenticate request on this server.

9. На вкладке Attributes выберите Attribute: User-Name и нажмите кнопку Add. Под Find: (.*)@(.*), а под Replace with: CIT\$1.

10.  На вкладке Advanced нажмите на кнопку Add выберите "Туннель-Medium-Type" и нажмите кнопку Add.
11.  Нажмите на кнопку Add и выберите 802 (Includes all 802 media plus Ethernet canonical format).
12.  Нажмите на кнопку OK дважды, чтобы вернуться и выбрать дополнительные атрибуты.
13.  Выберите "Tunnel-Pvt-Group-ID" и кликните Add.
14.  Кликните Add снова и введите имя VLAN, которое должен быть использовано: 1603.
15.  Нажмите на кнопку OK дважды, чтобы вернуться и выбрать дополнительные атрибуты.
16.  Выберите "Tunnel-Type" и кликните Add.
17.  Кликните Add снова и выберите Virtual LANs (VLAN).
18. Нажмите на кнопку OK, затем Next и Apply.
c. Eduroam
Для создания новой политики выполните следующие действия:

1. Щелкните правой кнопкой мыши на Connection Request Policy и выберите New Connection Request Policy.

2. Нажмите на кнопку Next.
3. Выберите A custom policy, заполните  Policy name (eduroam) и нажмите Next. 

4. Нажмите на кнопку Add , чтобы добавить критерии для подключения.

· Логин пользователя в Eduroam записывается следующим образом username@realm, где realm - доменное имя домашнего учреждения (поскольку eduroam пользователи могут быть из разных учреждений разных стран ставим просто .*@ .*).

5. Выберите User-Name и нажмите кнопку Add. Заполните критерий:     “.*@ .*”.
6. Выберите Client-IP-Address и нажмите кнопку Add. Заполните критерий: 10.127.255.9.
7. Нажмите на кнопку Next, а затем Edit Profile.

8. На вкладке Authentication укажите, куда запрос на проверку подлинности должен быть направлен и перенаправьте его на группу внешних серверов национального уровня eduroam: “Forward requests to the following remote RADIUS server group for authentication”.

9. На вкладке Advanced нажмите на кнопку Add выберите "Туннель-Medium-Type" и нажмите кнопку Add.
10.  Нажмите на кнопку Add и выберите 802 (Includes all 802 media plus Ethernet canonical format).
11.  Нажмите на кнопку OK дважды, чтобы вернуться и выбрать дополнительные атрибуты.
12.  Выберите "Tunnel-Pvt-Group-ID" и кликните Add.
13.  Кликните Add снова и введите имя VLAN, которое должен быть использовано: 1603.
14.  Нажмите на кнопку OK дважды, чтобы вернуться и выбрать дополнительные атрибуты.
15.  Выберите "Tunnel-Type" и кликните Add.
16.  Кликните Add снова и выберите Virtual LANs (VLAN).
17. Нажмите на кнопку OK, затем Next и Apply.
Шаг 6. Политики удаленного доступа.

Политики удаленного доступа — это упорядоченный набор правил, определяющих порядок авторизации подключения или отказа в подключении. Для каждого правила имеется одно или несколько условий, набор параметров профиля и настройка разрешений удаленного доступа.

Создадим две политики, для доступа из внешней(we abroad) и из внутренней сети (Wireless eduroam Users). 
1. We abroad. 
Для создания новой политики (обеспечивающей доступ всем беспроводным пользователям) выполните следующие действия:

1. Щелкните правой кнопкой мыши на Remote Access Policies и выберите New Remote Access Policy.

2. Нажмите Next, выберите Set up a custom policy и введите имя для политики: We abroad.

3. Нажмите далее.

4. Policy conditions - критерии, которые определяют, должен ли пользователь использовать данную политику.

5. Нажмите Add.
6. Выберите Client-IP-Address и нажмите кнопку Add. Заполните критерий: 80.94.174.231.

7. Выберите  Windows-Groups (имена групп Windows, к которым принадлежит пользователь, делающий попытку соединения) добавьте Domain Users.
8. Когда критерии определены, нажмите кнопку Next, выберите Grant remote access permission и кликните Next. 
9. Нажмите на Edit Profile и на вкладке Authentication, выберите Microsoft Encrypted Authentication version 2 (MS-CHAPv2), а также Unencrypted authentication (PAP, SPAP).
10.  Затем нажмите на EAP Methods, нажмите Add и выберите Protected EAP (PEAP)
11. Чтобы проверить, что PEAP будет использовать единственный сертификат (созданный в шаге 2), выберите Protected EAP (PEAP) и нажмите Edit. 

12.  Выберите EAP type: Secured password (EAP-MSCHAP v2), а также в строке Certificate issued выберите созданный вами сертификате.
13. Кликните на ОК, затем Next и Apply.
2. Wireless eduroam Users.
Для создания новой политики (обеспечивающей доступ всем беспроводным пользователям) выполните следующие действия:

1. Щелкните правой кнопкой мыши на Remote Access Policies и выберите New Remote Access Policy.

2. Нажмите Next, выберите Use the wizard to set up a typical policy for a common scenario и введите имя для политики: Wireless eduroam users.

3. Нажмите далее.
4. Выберите Access Method →Wireless определяющий каким пользователям разрешается доступ.

5. Нажмите Next.
6. В User or Group Access выберите User - User access permissions are specified in the user account (Права доступа указаны в учетной записи пользователя).
7.  В Authentication Methods выберите тип EAP который будет использоваться (Protected EAP(PEAP)).
8. Когда политика создана, зайдите в нее заново, выберите Grant remote access permission и нажмите на Edit Profile. 

9. На вкладке Authentication, выберите Microsoft Encrypted Authentication version 2 (MS-CHAPv2), а также Unencrypted authentication (PAP, SPAP).
10. Затем нажмите на EAP Methods, нажмите Add и выберите Protected EAP (PEAP).
11. Чтобы проверить, что PEAP будет использовать единственный сертификат (созданный в шаге 2), выберите Protected EAP (PEAP) и нажмите Edit. 

12.  Выберите EAP type: Secured password (EAP-MSCHAP v2), а также в строке Certificate issued выберите созданный вами сертификат.
13. Кликните на ОК, затем Next и Apply.
Шаг 8. Журнал событий.
IAS добавляет журнальные записи в Event Log (журнал событий)  и записывает их в файл. 

Откройте Control Panel → Administrative Tools → Event Viewer.

IAS создает следующие записи в журнале: Error, Warning и Information. Что отображено на рисунке 3.1.
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Рисунок 3.1 – Записи журнала событий.
Таким образом, успешное проведение экспериментов с тремя группами пользователей показывает работоспособность системы и соответствие ее политикам конфедерации Eduroam.  
ГЛАВА 4
ОБСУЖДЕНИЕ РЕЗУЛЬТАТОВ
В результате проведения исследований выполнен анализ характеристик и принципов работы беспроводной сети БГУ, определены основные проблемы, возникающие при аутентификации мобильных пользователей через RADIUS сервер.  Создана методика безопасного доступа в беспроводной сети, позволяющая контролировать подключение только легитимных беспроводных устройств, обеспечивать работу зарегистрированных пользователей, осуществлять передачу трафика с использованием защищенных протоколов. Разработана архитектура аутентификации мобильных пользователей, позволяющая включить корпоративный сегмент сети БГУ в национальный сегмент роуминговой аутентификации eduroam. Выполнены экспериментальные исследования по проверке разработанной архитектуры и методик. 
Заключение

В результате выполнения работы решены следующие задачи:

· Проанализированы основные элементы европейской системы eduroam.

· Проанализированы технологии безопасной аутентификации мобильных пользователей.

· Разработана сетевая инфраструктура Eduroam в корпоративной сети БГУ.

· Разработана система безопасности корпоративной сети БГУ для включения в федеративный сегмент.

·   Развернут беспроводной сегмент корпоративной сети БГУ на базе централизованной топологии с контроллером беспроводного доступа WiSM в центре и облегченными точками доступа.

· Создана модель взаимодействия корпоративного сегмента сети БГУ и национального сегмента сети Eduroam.

· Выполнены работы по установке, настройке и тестированию  корпоративного RADIUS сервера БГУ IAS Microsoft с целью его дальнейшего использования в системе роуминговой аутентификации.
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ПРИЛОЖЕНИЕ А
Предметный указатель к реферату

Eduroam, 9;

Network access elements, 10;

Supplicants, 11, 15, 20;
Enterprise Subordinate CA, 18, 22;
Приложение Б
Интернет ресурсы в предметной области исследования

i1. http://vak.org.by – сайт Высшей аттестационной комиссии Республики Беларусь. Здесь собраны все нормативные акты, касающиеся оформления и защиты диссертаций.

i2. http://www.eduroam.org. – официальный сайт конфедерации, на котором можно найти информацию о структуре политиках и участниках eduroam в Европе и во всем мире. Так же на сайте доступно множество документации по настройке и присоединению к edurоam.
i3. http://www.eduroamus.org – официальный сайт конфедерации eduroam в Америке, содержащий инструкцию по подробной настройке Internet Authentication Service для операционной системы Microsoft Windows Server 2003.
i4. http://www.eduroam.ie – официальный сайт конфедерации eduroam в Ирландии, содержащий множество инструкцию по настройке компьютера пользователя  для различных операционных систем.

i5. http://www.terena.org/ - сайт родительского проекта Eduroam. Транс-Европейской ассоциации исследовательских и образовательных сетей.
i6. http://www.geant.net/pages/home.aspx - сайт родительского проекта Eduroam, проекта мульти-гигабитной интернет сети, соединяющий в себе более 3500 образовательных учреждения в Европе.
i7. http://www.cisco.com – сайт американской транснациональной компании, разрабатывающей и продающей сетевое оборудование.
i8. http://technet.microsoft.com – сайт технической поддержки Microsoft.
i9. http://www.it.cornell.edu/cms/services/redrover/howto/eduroam - сайт Eduroam в Корнуэльском университете.
i10. https://www.ja.net/products-services/janet-connect/eduroam - сайт eduroam в Великобритании.
ПРИЛОЖЕНИЕ В
Действующий личный сайт в WWW
http://mavasechko.narod.ru/
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ПРИЛОЖЕНИЕ Г
Граф научных интересов

Магистранта Васечко М.А. факультет радиофизики и компьютерных технологий

Специальность Методы и системы защиты информации, информационная безопасность
	Смежные специальности

· 05.13.11 - математическое и программное обеспечение вычислительных машин, комплексов и компьютерных сетей

1. Математические методы, алгоритмы и средства для защиты программных продуктов от несанкционированного использования, обратного проектирования и модификации, в том числе с использованием достижений стеганографии, а также теории и практики эквивалентного преобразования алгоритмов. 

· 05.13.15 - вычислительные машины, комплексы и компьютерные сети

1. Методы и алгоритмы для создания локальных и глобальных компьютерных систем, а также технических и программных средств для реализации корпоративных клиент-сервер и глобальных технологий обработки распределенной информации.

2. Модели и методы параллельных вычислений на основе принципов отображения алгоритмов на параллельные однородные вычислительные структуры для синтеза высокопроизводительных вычислительных машин, комплексов, систем и компьютерных сетей.


	Основная специальность

05.13.19 – методы и системы защиты информации, информационная безопасность, физ.-мат.

1. Математические модели, методы для формирования требований и оценки безопасности систем защиты информации. Теория и методология обеспечения информационной безопасности и защиты информации. Модели, методы и инструментальные средства защиты информации и обеспечения информационной безопасности.

2. Математические модели и методы для формирования требований и оценки безопасности программных и аппаратно-программных средств защиты информации. Разработка новых и повышение эффективности существующих аппаратных, программных и аппаратно-программных средств криптографической защиты информации (шифрования, электронной цифровой подписи, управления доступом, контроля целостности, генерации ключевой документации). 


	сопутствующие

· 05.12.13 - системы, сети и устройства телекоммуникаций

1. Создание или развитие теоретических основ сетей, новых видов систем и устройств телекоммуникаций.

2. Совершенствование существующих и разработка новых сетей, систем и устройств телекоммуникаций на основе современных научно-технических достижений.




ПРИЛОЖЕНИЕ Д
Тестовые вопросы по ОИТ

<question type="close" id="067">

<text>1 Язык разметки гипертекста это – </text>

<answers type="request">

<answer id="1" right="0"> CSS </answer>

<answer id="2" right="0"> Java </answer>

<answer id="3" right="1"> HTML </answer>

<answer id="4" right="0"> SQL </answer>

</answers>

</question>

<question type="close" id="567">

<text> 2 Различают три основных вида топологии компьютерной сети. К ним не относится:</text>

<answers type="request">

<answer id="1" right="0"> Шина</answer>

<answer id="2" right="1"> Дерево</answer>

<answer id="3" right="0"> Звезда </answer>

<answer id="4" right="0"> Кольцо</answer>

</answers>

</question>

ПРИЛОЖЕНИЕ Е
Презентация магистерской диссертации
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1. BHIIOAHNT aHAAN3 APXUTEKTYPHl ¥ IIPABILA
MeXAyHapOAHO CHCTeMbl DOYMUHIOBOI
ayrentudukamym Eduroam.

2. Pa3paboTaTs apXITEKTypy KaMIIYCHOIO GeCIpOBOAHOTO
cermeHTa cuctemsl Eduroam B cetn BI'Y.

3. PaspaboTath CuCTeMy DOYMUHIOBOJT ayTeHTHbUKaImmn
B cetnt BI'Y Ha ocHose nepapxim RADIUS cepsepos.

4. PeaansosaTh TeCTOBYIO MOJeAb KaMIIYCHOTO CerMeHTa
BI'Y u mpoBecTn sKCIiepuMeHTaAbHEIe JICCASAOBAHIA
TIO ee IpOBepKe.
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« EAP - Extensible Authentication Protocol
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o EAP-TLS
o EAP-PEAP
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5. B mponecce ycranopku u kouburypammu IAS Microsoft
RADIUS cepsepa GBLIO BEIIOAHEHO:

Veranosxka Windows 2003 Enterprise edition

Toaxamouerie DHCP cepsepa 11 cepsepa cepTiduKaTos

Veranosxa i HactpoixkaDNS cepsepa.

Jlobasaere xanerTos s IAS

TloaK/IOYeHITe IOATITIIK 3aMPOCOS Ha TOAKAIONEHTIe.

TloaKAIOYerIIe HOATIK YARIEHHOTO AOCTYTIa.

Hactpoitxa arpr6yTos RADIUS cepsepa.

'HacTpoitka TakiX IpoToK0108 ayTenTidKamm kax: EAP, PEAP,

Microsoft Challenge Handshake Authentication Protocol (MS-CHAP

02).

PN RN
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6. BEIIOAHEHHI THUIIOBBIE HACTPOJNKM Ha KOMITBIOTEpE
TI01b30BaTeAs C ONEPalNOHHOM CHUCTeMOM Windows
2007:

o Hactpoiixa ivern ety — SSID ceTn, K KOTOpOit B5l XOTUTe
ToAKAIOTTECA

o Hactpoiixaina GesonacHocr ~-WPA2

o Hactpoiixana mudposarns -AES

o Hactpoiixa MeToaa nposepxi1 noaanssocri - EAP MSCHAPy2
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B xoae BBImOAHeHNMA paGoTH Obaa paspaGoTaHa u
BHEApeHa CICTeMa MOGIABHOTO aBTOPU30BaHHOTO AOCTyTIa
K MHOOPMATIMOHHEIM pecypcaM ¥ 21eKTPOHHBIM yCAyTaM
BI'Y(2AeKTPOHHBIN KaMIIyC), YIUTHBAIOMIAA OCOGEHHOCTI
HAI[MOHAABHOM TeAeKOMMYHMKAaIIMOHHO I
MHGPACTPYKTYPEl ¥ TUIIOBBE peleHs o Ge30macHOCTH,
ucroas3yemsle B Geaopycckux Bysax. JaHHaz cucrema
obecrreunsaeT yHTerpammo B Eduroam.
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TIpoBeaeHs! SKCTIepUMEHTaAbHbEe MCCAEA0BAHIIA TeCTOBOI
MOAeab KaMITyCHOTO cermeHTa BI'Y myTem MoaeamposaHmsa
ABYX ayTeHTHUIMPYIONTNX 3aIPOCOB:
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TIEPEAAIOTCH B €10 AOMATITHIOW CeTh, TA€ POMICXOAIT
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eduroam BTV 11 rocTs moaywaeT 40cTyH K yeiyre VsTeper.
o Tloassosateas BIY 13 TocTesoit ceTn ayTeHTHHINPYeTCH depes

mertouxy npoxar RADIUS cepsepos 5 Jovere BSUn moaywaer
AOCTYTI K yCAYTaM B TOCTeBOii CeTH.
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